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WARNINGS 

THE IMPROPER USE OF THIS INSTRUMENT CAN PRESENT AN 

ELECTRICAL SHOCK HAZARD THAT CAN CAUSE DEATH OR 

SERIOUS INJURY. 

 

THIS INSTRUMENT SHOULD ONLY BE USED AS DESCRIBED IN THIS 

OPERATIONS MANUAL. 

*** 

 WARNING THIS INSTRUMENT MAY PRESENT AN ELECTRICAL SHOCK 
HAZARD WHICH CAN RESULT IN DEATH OR SERIOUS INJURY IF THE 
FOLLOWING PRECAUTIONS ARE NOT FOLLOWED: 

 

• THIS INSTRUMENT MUST ONLY BE USED FOR TAKING ELECTRICAL CURRENT 

AND VOLTAGE (I-V) CURVES OF PHOTOVOLTAIC (PV) SOLAR MODULES. 

 

• THIS INSTRUMENT MUST NOT BE USED BEYOND ITS OPERATING RANGE.  

 

• THIS INSTRUMENT MUST NOT BE USED BY PERSONNEL WHO DO NOT HAVE 

EXPERIENCE HANDLING HIGH VOLTAGE DC AND PHOTOVOLTAIC MODULES. 

 

• THIS INSTRUMENT MUST NOT BE USED DURING RAIN, SNOW, SLEET, OR IN 

ANY AREA OF HIGH MOISTURE SUCH AS AREAS WITH STANDING WATER OR 

MUD. 

 

• THIS INSTRUMENT MUST NOT BE USED IF IT IS NOT FUNCTIONING AS 

DESCRIBED IN THIS USER MANUAL . 

 

! 
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NOMENCLATURE 

A Amperes or Amp 

Hz Hertz 

I Current 

Ipk Current at peak power 

Isc Short-Circuit Current: The maximum current a photovoltaic cell can 

generate with the output terminals shorted 

I-V Current-Voltage 

PV Photovoltaic 

V Voltage 

V
HIGH

 High voltage range < 600 Volts 

V
LOW

 Low voltage range < 150 Volts  

Voc Open-Circuit Voltage: The maximum voltage a photovoltaic cell can 

generate with the output terminals open circuited 

Vpk Voltage at peak power 
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1.0   Installation & Taking IV Curves 

Basic Description 

The standard DS-100C Tracer has two user selectable current ranges (10 and 

100 Amperes), three automatically selected voltage ranges (600, V, 60 V,  and 6 

Volts), two irradiance and two temperature measurement inputs. Unless 

otherwise noted, this manual refers to standard DS-100C models. 

Note: The three measurement voltage ranges listed here should not be confused 

with the load ranges (V
HIGH

 and V
LOW

) selected with the range switch. 

A computer running the IVPC for Windows program controls the DS-Tracer.  

(See the IVPC Reference Manual). The computer running the IVPC application 

may be connected to the DS-Tracer by RS-232 serial or USB. 

Most DS-Tracer operations are performed with the IVPC program. Refer to the 

IVPC manual for details on operating the DS100C IV Tracer. However, the basic 

steps for using the DS-Tracer are: 

• Connect the DS-Tracer to the computer (either RS-232 or USB). 

• Turn on the tracer power and connect DS-Tracer test leads to PV array. 

• Connect pyranometers and thermocouples to DS-Tracer. 

• Install and run IVPC for Windows (see the IVPC manual for details). 

• From File menu select New I-V Curve. 

• Enter curve information and take curve. 

• Save curve data. 

To proceed with the Installation & Quick-Start, you will need the following: 

• DS-Tracer I-V curve tracer and test leads. 

• IVPC CD-ROM. 

• PC computer running the Microsoft Windows® operating system. 
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• Serial or USB cable to connect your computer to the DS-Tracer. 

IVPC Installation 

IVPC is written for use with Windows® 98/2000/XP which must be running to 

operate IVPC. To install IVPC, insert the IVPC CD-ROM in your computer. Open 

the IVPC CD-ROM and run the “setup.exe” program by double click with the 

mouse. 

The setup program will prompt you for information on where you want to install 

IVPC. If you are unsure, use the defaults which create an IVPC sub-directory off 

of the root directory on drive C:. IVPC Setup automatically installs the necessary 

files in the IVPC directory and makes additions to your Windows system 

directory.  

 

Precautions 

There are several precautions to observe before using the DS-Tracer and IVPC 

to take I-V curves. 

• The DS-Tracer battery should be fully charged.  The DS-100C has a universal 

power supply that works with AC line voltages from 85 Vac to 264 Vac 50/60 Hz.   

• The DS-Tracer DISCONNECT switch should be in the OFF position and the DS-
Tracer power should be turned on when making or breaking connections to a PV 
system or when changing the voltage range switch. 

• The DS-Tracer should be connected to the PV array through a PV system 
disconnect switch capable of interrupting the short-circuit current of the array at 
peak-power voltage. This ensures that you can disconnect the DS-Tracer if a 
problem occurs. Refer to the DISCONNECT switch discussion in section 2.0   
Panel Layout for details. 

 NOTE: The DS-Tracer DISCONNECT switch is not rated to interrupt high 
voltage systems producing more than five amps. 

• Do not connect the DS-Tracer to anything other than an open-circuited PV 
system. Be sure the PV array is electrically isolated from power conditioning 
equipment such as charge controllers or inverters. 

! 
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• Do not connect the DS-Tracer to a PV system with an open-circuit voltage greater 
than 600 Volts. 

• Do not connect the DS-Tracer to any PV system with a short-circuit current 
greater than maximum for your unit (100 Amperes for a standard DS-100C). 

 The DS-Tracer RS-232 and USB ports, irradiance inputs, temperature inputs, 
auxiliary analog inputs, and auxiliary charge inputs are all referenced to the 
same electrical common inside the tracer. Therefore these devices must be 
either electrically floating  or referenced to the same electrical common. 

However, all of these connections are electrically isolated from the PV inputs. 

Connecting Your Computer to the DS-Tracer 

The DS-100C IV Tracer provides two interfaces; an RS-232 and USB port. The 

RS-232 interface uses a standard female, 9 pin connector as shown in Figure 8. 

The standard USB connection is labeled “Main USB.” Either of these 

connections may be used depending on the configuration of the computer 

running the IVPC program. Though, only one of these ports should be connected 

at a time. 

Note: Special USB drivers must be installed on the computer in order to use the 

USB port. See the section Appendix C    DS-100 USB Drivers for details on 

installing these drivers. 

Connecting a PV Module to the DS-Tracer 

The DS-Tracer is connected to the PV array or module with the test leads 

provided. Before connecting a PV module, be sure the DS-Tracer power switch 

is ON and the DISCONNECT switch is in the OFF position. Plug the test lead 

into the DS-Tracer being sure to match the red and black connectors. The 

Voltage Sense connector is keyed and can only be inserted in one way.  

 For safety, it is recommended that connections be made to a circuit that can 
be isolated from the PV array with a system switch rated at full PV power.  
Refer to section 2.0   Panel Layout for details. 

! 

! 
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With the DS-Tracer DISCONNECT switch still OFF, attach the test leads to your 

PV module.  By making connections with the PV system disconnect switch off, 

the chance of electric shock is avoided. After connecting the test leads, close the 

PV system switch. At this point, PV voltage should be present at the DS-Tracer. 

Turn the DS-Tracer DISCONNECT switch to ON. Note: For normal operation, 

the DS-Tracer DISCONNECT switch should always be the last switch closed and 

the first switch opened. 

Starting IVPC 

The following description assumes the use of IVPC 2.X.  IVPC opens to the Data 

Grid window shown in Figure 1. IVPC Data Grid window.. The Data Grid is a 

spread sheet that lists all of the I-V curve data files stored in the current 

directory. When starting IVPC for the first time the Data Grid may be empty if no 

I-V curves have been taken. 

 

 

Figure 1. IVPC Data Grid window. 

The Data Grid can be thought of as a detailed directory of the I-V curves. 

However, in addition to file names, you can display other curve data such as 

peak-power or module ID. Refer to the IVPC Reference Manual for directions for 

changing the data displayed. Use the Data Grid to locate and display I-V curves 

that were taken previously and stored. 
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Taking an I-V Curve 

Before taking a curve, the DS-Tracer should be turned on and connected to the 

PV system. Your computer should be connected to the DS-Tracer and running 

IVPC. From the File menu, shown in Figure 2, select New I-V Curve or press 

Ctrl-N (control and N keys at the same time).   

 

 

Figure 2. Select New Curve in the File menu to take an I-V curve. 

 Note:  Some figures shown in this manual may be different than your version 
of IVPC. Please refer to the IVPC manual for the most up-to-date information 
on using IVPC..   

! 
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IVPC will open a new curve window as shown in Figure 3. This window provides 

areas to enter curve information identifying the I-V curve. The DS-Tracer takes 

up to 12 seconds to initialize the tracer hardware. Typically you will enter curve 

data during this delay. For example, if not using the Auto feature to read an 

irradiance or temperature channel, you could enter a value manually at this time. 

A status message indicating that the DS-Tracer is pre-charging is displayed in 

the area normally used to plot the curve.  

 

 

Figure 3. New Curve screen while DS-Tracer is pre-charging. 
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After initialization, the status message changes and the Take Curve button is 

enabled as shown in Figure 4. The status message indicates that a curve can be 

taken by using the mouse to press the Take Curve button or by pressing Alt-T. 

 

 

Figure 4. DS-Tracer is pre-charged and ready to immediately take the curve. 
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After pressing Take Curve, the DS-Tracer takes approximately 6 seconds to take 

the curve and plot the data as shown in Figure 5. You may save this data by 

selecting Save I-V Curve from the File menu. The curve is stored in the current 

directory and the Data Grid is updated. 

 

 

Figure 5. Example of I-V curve. 
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You can return to the Data Grid without closing the curve window by using the Window 

menu shown in Figure 6. Closing the I-V curve window will also return you to the Data 

Grid window. 

 

 

Figure 6. Moving to the Data Grid with the Window menu. 

If You Get an Error 

There are several error messages you may see when taking a curve. The DS-

Tracer automatically turns itself off when it does not receive a command for 15 

minutes. This features helps to protect the DS-Tracer battery. If the DS-Tracer 

has been on for more than 15 minutes without taking a curve it will power down 

and you will receive an error indicating that the DS-Tracer does not respond. 

Simply turn the DS-Tracer switch off, wait several seconds, and turn it back on. 

Allow the tracer approximately 10 seconds to initialize.  Then pressYes to retry 

as indicated on the error dialog box. 

Other errors occur if the PV array voltage is too high or if it is zero or negative. 

Simply follow the IVPC directions given when the error occurs. Most errors 

happen as soon as you chose New I-V Curve from the File menu. Most often you 

can correct the problem and continue without having to restart. 

The most common problem results from a communication error. This is usually 

due to not setting the correct COM port in IVPC. The COM port settings must 

match the actual COM port on your computer. Note: If the COM port is a “virtual” 
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COM port, such as those created by USB to serial adapters or by the DS-100C 

USB drivers used for IVPC version 2.X and older, it is possible that this COM 

port number has been inadvertently changed.  

Use the Windows device manager to confirm the current COM port setting of the 

virtual COM port. The COM port number set for this virtual port must match the 

COM port number set in IVPC. 

Displaying Saved Curves 

Stored I-V curves are selected from the Data Grid. The Data Grid displays the 

curve files in the current directory. Be sure to set the current working directory to 

the sub-directory where the curves are stored. Use the Change Directory 

command in the File menu to select a new directory as shown in Figure 7.  

To display a curve shown on the Data Grid, double click anywhere on the row for 

that curve. A window very similar to the one used to take a curve is displayed. 

More than one curve window may be open at the same time. Use the Window 

menu to return to the Data Grid and select another curve. The Window menu is 

also used to switch between curve windows. 

 

 

Figure 7. Change Directory dialog box. 
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Summary of Steps for Taking IV Curves 

1.  Connect your computer to the DS-Tracer and start IVPC for. Turn the power 
switch of the DS-Tracer ON. 

2. You can connect one or two pyranometers directly to the DS-100C. If 
pyranometers are connected you must enter correct pyranometer constants in 
IVPC.   Refer to the IVPC manual for details.  

3.  You may connect one or two thermocouples directly to the DS-100C Refer to the 
IVPC manual for details. 

4.   Open the PV array system switch to isolate the PV array under test.  NEVER try 
to take a curve of a PV array connected to a battery or inverter. 

5. With the DS-Tracer DISCONNECT switch in the OFF position, connect the PV 
system to the DS-Tracer front panel using the leads provided. (Red is positive, 
black is negative.) Plug the red and black leads and the voltage sense plug into 
the mating connectors on the DS-Tracer; then connect the negative lead to the 
PV array followed by the positive red lead. Be sure to connect the tracer to the PV 
system through a system disconnect switch rated for Isc and Voc. Refer to the 
discussion of the DISCONNECT switch in the section 2.0   Panel Layout. 

6. Set the voltage-range switch to the desired setting, VLOW or VHIGH.  Leave the 

voltage-range switch in the VHIGH position unless taking a curve of a high current 

(> 50 Amperes), low voltage (< 24 Volts) PV array. 

7. Turn the DS-Tracer DISCONNECT switch to the ON position. The DS-Tracer is 
now ready to take I-V curves.  

8. From the File menu in IVPC select “New I-V Curve”.  

9.  To take another I-V curve of the same PV system, repeat step 9. 

 To test another PV subsystem, turn the DS-Tracer DISCONNECT switch to OFF 
and open the PV system disconnect switch. Remove the cables and repeat steps 
5 through 9. 

 WARNING: Disconnecting cables when the array disconnect switch is ON may 
result in electrical arcing and may damage the DS-Tracer and/or injure the 
operator. 

10. When finished taking curves, turn the DS-Tracer DISCONNECT switch to the 
OFF position and open the PV system disconnect switch. Disconnect the DS-
Tracer from the PV system. Remove the positive, red lead first followed by the 
negative lead.  

11. Switch off the power to the DS-Tracer. 

! 
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2.0   Panel Layout 

This section describes the DS-100C photovoltaic I-V curve tracer in more detail.  

The DS-Tracer generates a complete current-voltage (I-V) curve that 

characterizes the photovoltaic system under test. Figure 8 shows the front panel 

layout of the DS-100C. Each of the key components is described in detail in the 

following section. 

TEMP #2

TEMP #1

RS-232

AUX CHARGE

!
25V DC

IRRADIANCE #2

IRRADIANCE #1

1/4 A, 250V
FAST FUSE

600V DC!

!

PV

1 A,   25 0V 

SL O W  F US E

50/60 Hz
85 - 264 V AC

POWER

2 A, 250V
FAST FUSE

MAIN USB

AUX USB

!

VLOW

!

VHIGH

PRECHARGE

RANGE

DISCONNECT

VOLTAGE
SENSE

daystar, inc.

Manufacturedby Raydec, Inc., Albuquerque, NM

E N E R G Y   E N G I N E E R I N G

daystar
daystar

FULL 
CHARGE

TURN DISCONNECTSWITCH OFF 
BEFORECONNECTING OR 
DISCONNECTING PV ARRAY

TURN DISCONNECTSWITCH 
OFFBEFORECHANGING 
VOLTAGE RANGE

DS-100C

PHOTOVOLTAIC

I-V CURVE TRACER

AUX INPUT

11

9

8

76

5

4

3

1
17

13

10

2

16 15

14

12

 

 

1.  Pre-Charge Fuse (if present) 10. On-Off Switch 

2. Voltage Sense Connector 11. Full-Charge Indicator 

3. Positive PV System Connector 12. AUX USB Port 

4. Negative PV System Connector 13. Main USB Port 

5. Disconnect Switch 14. Thermocouple Inputs 

6. Voltage Range Switch 15. RS-232 Serial Port Connector 

7. AC Supply Input & Fuse 16. AUX Analog Inputs 

8. DC Supply Input 17. Irradiance Inputs 

9. DC Supply Input Fuse   

Figure 8. Face plate of the DS-Tracer. 
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Pre-Charge Fuse 

Note: New tracer configuration do not use a pre-charge fuse.  

The DS-Tracer uses a pre-charge circuit to apply a negative voltage to the DS-

Tracer load capacitors before taking a curve. The pre-charge fuse (if present) 

protects the pre-charge circuit if it is inadvertently active while the DS-Tracer load 

capacitors are sweeping an I-V curve. Typically this fuse blows if the DS-Tracer 

DISCONNECT switch is turned on or off during the pre-charge cycle. Replace 

the fuse with only a 1/4 A Fast 3AG fuse. Refer to the section 5.0   Pre-Charge 

Precautions for more details and information on the potential damage the pre-

charge can do to thin-film PV modules. 

 Note: Only replace this or any other fuse with the DS-Tracer completely 
disconnected from the PV array. 

PV & Voltage Sense Connectors 

When an I-V curve is taken, the load current flows through the test lead into the 

large red and black PV connectors. The red and black connectors go to PV array 

positive and negative terminals respectively. The PV array voltage is measured 

separately to avoid measurement errors caused by voltage drops in the test 

leads. The test leads incorporate voltage sense wires that run between the 

Voltage Sense connector and the ends of the test leads.  

DISCONNECT Switch 

The DISCONNECT switch is used to isolate the DS-Tracer from the PV array 

when connecting or disconnecting the test leads between the tracer and PV 

system. Having this switch in the OFF position ensures that no significant current 

can flow into the DS-Tracer while making or breaking connections. This feature 

prevents the possibility of an electrical arc and protects the user from possible 

injury. Although the DISCONNECT switch should always be OFF when 

! 
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connecting or disconnecting the test leads, it becomes more important at higher 

PV voltages. 

 Note: the DS-Tracer DISCONNECT switch is not rated to break the electrical 
current at the full voltage and current rating of the DS-Tracer. 

 The DS-Tracer should always be connected through a PV system disconnect 

rated at the PV system Voc and Isc values as shown in Figure 9. A system switch 

provides a way to break a circuit should the DS-Tracer have a major internal 

failure. 

 

Figure 9. Use of PV system disconnect switch. 

Voltage Range Switch 

The voltage-range switch changes the electrical configuration of the capacitors 

that form the load for the PV array. It will not affect the measurement range of 

the I-V curve but it does affect how quickly an I-V curve is taken. In the low 

voltage setting, the DS-Tracer has more load capacitance and therefore a curve 

is swept slower. Note: This affects how quickly the PV array sweeps from Isc to 

Voc. It does not affect how long it takes a curve to plot in IVPC.  

The higher Isc and the lower Voc the more quickly a curve is taken. If curves are 

swept too fast, the dynamic characteristics of the PV array can become 

! 
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PV Array 

System 
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significant and affect the accuracy of an I-V curve. Under most circumstances, 

the DS-Tracer can be left in the VHIGH range. However, the low voltage range 

will give a better curve of low voltage, high current PV systems (for example 60 

Amps, 12 Volts).  Refer to section 3.0   Theory  for more details on DS-Tracer 

capacitance. 

 NOTE:  Leave the voltage range switch on the DS-Tracer in the HIGH position 
unless taking a high current, low voltage I-V curve.   

AC Power Entry & Fuse 

The DS-Tracer battery is recharged by connecting the DS-Tracer to an AC power 

source with the cord provided. It is not necessary for the tracer to be ON. Refer 

to section 4.0    for details of battery charging. 

ON-Off Switch 

This switch turns on the DS-Tracer power. This switch should be on before 

connections are made to a PV array. The curve tracer takes approximately 10 

seconds to initialize after it is turned on. Be sure to allow for this before 

attempting to use IVPC to operate the tracer. If you attempt to communicate with 

the tracer before it completes initialization, you will receive an error in IVPC.  

It makes no difference if it is on or off while connecting to the control computer. 

Of course, it must be on to take an I-V curve. The DS-Tracer automatically turns 

itself off if a curve has not be taken for 15 minutes. This feature protects the DS-

Tracer battery. If you suspect that the DS-Tracer has turned itself off, simply 

switch the power switch off, wait several seconds, and turn the switch back on. 

Full Charge Indicator 

When this LED lights its indicates that the DS-Tracer battery is fully charged. 

Sometimes this LED will turn on for several seconds if the AC power cord is 

! 
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unplugged before the battery is fully charged. This occurrence does not indicate 

a fully charged battery. 

Aux Charge Power & Fuse 

The Aux Charge connector is a standard banana jack connector used to 

recharge the battery from a DC power source such as a PV module. Do not 

exceed the input voltage.  A fuse protects the tracer from excess current. 

RS-232 Serial Port 

All DS-Tracer operations are controlled with commands sent to the DS-Tracer 

through this serial port or the USB port. This port is a standard 9 pin RS-232 

port. This port is configured as a DCE device. Normally the DS-Tracer functions 

are controlled with the IVPC software, but you can create your own software 

using the DS-Tracer command codes described in section 6.0   DS-100C 

Additional Capabilities. 

The DS-Tracer uses the following RS-232 format: 

 
9600 Baud 
No parity 
8 data bits 
1 stop bit 
  

Main USB Port 

All DS-Tracer operations are controlled with commands sent to the DS-Tracer 

through this USB port or the RS-232 port. This port is a standard USB Type-B 

port. Normally the DS-Tracer functions are controlled with the IVPC software, but 

you can create your own software using the DS-Tracer command codes 

described in section 6.0   DS-100C Additional Capabilities. 

  

Aux USB Port 

This port supports auxiliary DS-100C operations This port is a standard USB 

Type-A port. This port is NOT used to control the DS-100C IV tracer. It is meant 
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to be used to update the IV curve tracer internal firmware and to load updated 

calibration constants. In the event that an update is needed, the proper use of 

this port will be described at that time. This port may also be used for advanced 

features in future releases of DS-100C firmware or IVPC. 

  

Irradiance Inputs 

The model DS-100C has two irradiance inputs for measuring pyranometers.  

These inputs measure DC voltages only. In order to use a reference cell, the cell 

must have a shunt resistor attached to convert the cell current to a voltage. Refer 

to  the IVPC Manual and Appendix C “DS-Tracer Technical Specifications” for 

details on the voltage range of the irradiance inputs. 

These inputs are differential, but there is a 10 K resistor form the negative 

(black) input and the internal circuit common. Therefore the pyranometer can be 

either electrically referenced to the same common as the other inputs such as 

the computer, or it can be electrically floating.  

Thermocouple Inputs 

The standard model DS-100C is configured with two Type “T” thermocouple 

inputs for measuring PV array module temperatures.   Refer to the IVPC manual 

for details on making temperature measurements and Appendix C    DS-100 

USB Drivers for details. 

Aux Analog Inputs 

This auxiliary analog input connection is currently disabled. However, 

implementation is expected n future releases of IVPC and DS-100C firmware. 
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3.0   Theory of Operation 

The DS-Tracer obtains an I-V curve by varying the electrical impedance 

connected across the PV array output terminals. Varying the impedance from 

zero to infinity causes the array operating point to change from I
sc

 to V
oc

. The 

DS-Tracer accomplishes this impedance change by connecting the array to a 

capacitive load. As the capacitor charges, the array moves through its operating 

range and presents a set of current and voltage values that form the I-V curve.  

When the capacitor load reaches V
oc

 data sampling stops. 

The DS-Tracer employs two high-speed, analog-to-digital converters to sample 

the current and voltage. One converter digitizes the array voltage while the other 

digitizes the array current. The DS-Tracer analyzes the digitized values, saves 

those that show significant change, and transfers the data set to the control 

computer. The data set includes the I-V curve data plus values of open-circuit 

voltage, V
oc, and short-circuit current, I

sc
. Peak-power, voltage at peak-power 

Vpk, current at peak-power Ipk, and fill factor are calculated and displayed with 

the curve.  

Irradiance and temperature data, and array identification may be added to each 

data set.  The irradiance and temperature data are either entered by the operator 

using IVPC or sampled by the DS-100C.  

The DS-Tracer sweeps an I-V curve by switching the PV system to a bank of 

capacitors. As these capacitors charge, the PV system voltage increases until 

open circuit voltage is reached. While the voltage is increasing, and the current 

to the capacitors is decreasing from its maximum, short-circuit value, the voltage 

and current are sampled by high-speed analog-to-digital converters. These data 

points define the I-V curve. 

Before acquiring data, the DS-Tracer reverse charges its capacitive load to 

approximately -25 V. This negative pre-charge is used to offset any voltage 
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drops created by the test leads and to allow any switching transients to settle 

before Isc is reached. This method allows a true short circuit current reading to 

be made. The DS-Tracer allows 5 seconds for a curve to reach open circuit 

voltage. At this point the circuitry discharges the capacitors through a resistive 

load. 

The complete cycle actually begins with a discharge of any residual voltage on 

the capacitors. This discharge is followed by 7 seconds of pre-charge, 5 seconds 

to take the curve, and finally another 5 seconds for discharge. The initial 

discharge cycle is not normally needed. However, it ensures that the load 

capacitors are ready to accept a pre-charge. The initial discharge, if needed, 

may take up to 5 seconds. 

The DS-Tracer uses an SCR to close the circuit between the PV system and the 

load capacitors. SCRs are susceptible to false triggering (turn on) if the voltage 

across them is increased too rapidly. The DS-Tracer DISCONNECT switch uses 

two 1MΩ resistors (one each for the positive and negative leads) across the 

disconnect switch contacts. These resistors allow the SCR to “see” the PV 

system voltage before the DISCONNECT switch is closed; thereby preventing 

the SCR from false triggering when the disconnect switch is closed. Under 

normal operating conditions, this switch should always be the last switch closed 

and the first switch opened when making PV system connections. 

 Note: In an emergency situation, it is recommended that the PV system switch 
be opened first. The DS-100C disconnect switch is not rated to break 
significant current at high voltage. 

Some PV systems are sensitive to how quickly an I-V 
curve is taken. The speed of a curve is most easily 
expressed in volts per second by taking the PV short 
circuit current in Amps (Isc) and dividing it by the DS-
Tracer load capacitance in Farads. Refer to 

! 
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Appendix D - DS-100C Technical Specifications for the values of load 

capacitance for each position of the voltage-range switch. For example, if using a 

load capacitance value of 0.005 F (low range), and a PV system with an Isc of 

20A the rate would be: 

Rate =  20A/0.005 F = 4000 V/S. 

When comparing this value to the PV system, it is best to normalize this rate to 

an individual PV cell. This can be done by dividing the rate by the number of PV 

cells in series. If the previous example had fifty cells in series the rate of each 

cell would be 4000 V/S÷ 50=80 V/S. Different PV technologies vary in their 

sensitivity to the charge rate. It is left to the user to determine if there is reason 

for concern. Often the PV module manufacturer can provide information 

concerning how quickly an I-V curve can be swept on their modules. Daystar, 

Inc. will also provide any assistance possible. 
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4.0   Maintenance 

Battery Charging and Care 

The DS-Tracer contains a 12-Volt sealed, maintenance-free, lead-acid battery. 

(A 5 AH Cyclon brand, #0809-0012 manufactured by Hawker Energy.) The 

battery is designed for 400 cycles of a 50 percent discharge. Using the DS-

Tracer for 6 hours continuously discharges the battery 50 percent. If the DS-

Tracer were used for 6 hours every day, the battery should have a minimum life 

of 13 months (one discharge/charge cycle a day). Fully charging the DS-Tracer 

after every use increases battery life. The DS-Tracer is programmed to turn itself 

off after 15 minutes without a command. This eliminates the possibility of 

completely discharging the battery if the DS-Tracer power is accidentally left on. 

The DS-Tracer battery may be charged in two ways–AC line power or a DC 

source such as a PV module. The DS-100C has a universal AC power supply 

and therefore will work with single phase, AC line voltages from 85 Vac to 264 

Vac 50/60Hz. To charge the battery from AC line power, simply connect the 

tracer to the AC source (with the AC power cord provided). The tracer will 

immediately start charging the battery  

Battery charging is independent of using the DS-100C tracer. Therefore the 

tracer may be used to take curves using AC power. The battery will continue to 

charge while the tracer is used. 

 NOTE: In order to minimize potential ground loops and maximize safety, it is 
recommend that the DS-100C NOT be connected to AC power when taking 
curves. However, this is only to eliminate.   

In addition to using AC power, you can connect a DC supply such as a PV 

module to the DC input connector. This feature is useful when working in remote 

locations without AC power. Connect a DC Voltage source within the range 

specified on the DS-Tracer front panel to the DC Power connector. This is a 

! 
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standard banana jack connector. Connect the DC positive and negative to the 

red and black jacks respectively. 

The charge circuit uses a maximum of 1 A and requires a minimum of 16 V. If 

using a PV module for recharging, the open circuit voltage of this module should 

not exceed the maximum rating shown on the DS-Tracer front panel. If you 

connect a supply that produces less than 1A, the DS-Tracer simply takes longer 

to recharge.  The internal charging circuitry limits the DC charging current. 

Therefore power sources with current capabilities greater than 2 A can be used. 

For example, a 5 A PV module could be used. The DS-Tracer will only draw the 

current it needs for charging. 

The automatic charging system maintains the battery at its peak charge level 

and will not overcharge the battery. When the battery is fully charged, the full-

charge indicator comes on. You do not need to turn the DS-Tracer on to 

recharge the battery. Operating the tracer will not affect the time it takes to 

recharge. 

It will not harm the battery to leave the DS-Tracer connected to the power source 

after the battery is fully charged. Note: The full charge indicator may come on for 

a short time if the charging power is removed before the DS-Tracer is fully 

charged. This occurrence does not indicate that the battery is fully charged. 

During charging, the front panel of the DS-100C near the irradiance connectors 

may get slightly warm. 

Exterior Cleaning 

The exterior surface of the DS-Tracer may be cleaned with a soft cloth damped 

with water or a mild soap only. Do not use detergents, abrasive cleansers, or 

other solvents.  
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Transportation 

Treat the DS-Tracer as you would a notebook computer.  The DS-Tracer is 

mounted in a heavy-duty case but this is NOT adequate to ship the unit as freight 

without using a shipping container. Because of its weight, it will likely be 

damaged if it is dropped or tossed. Due to airline security, Daystar does not 

recommend attempting to carry the tracer on board a commercial airplane as 

carry-on baggage  A shipping container with foam packing is supplied as 

standard equipment with all DS-100C curve tracers. Daystar strongly 

recommends using this case anytime the DS-100C is shipped. 

DS-Tracer Fuses 

The DS-Tracer has three externally accessible fuses. The first of the external 

fuses is located in the AC input power receptacle. Power line surges or internal 

faults can cause this fuse to fail.  Return the DS-Tracer for repairs if this fuse 

blows repeatedly. Replace this fuse with the type indicated on the DS-Tracer 

panel. 

A user accessible fuse is located on the front panel and is labeled “PRE-

CHARGE” fuse. This 1/4 Amp, fast-blow fuse protects the DS-Tracer pre-

charge circuitry. See section 5.0   Pre-Charge Precautions for more details. This 

fuse may blow if the DS-Tracer connection and disconnection sequences are not 

followed exactly.  Replace only with a 1/4 Amp, fast-blow fuse.   

A third user replaceable fuse is the 2 Amp, fast-blow DC charging fuse. This 

fuse should only blow if a DC source voltage exceeds the rating on the DS-

Tracer panel.  Replace only with a 2 Amp, fast-blow DC charging fuse. 

There is an internal fuse on the power supply board battery circuit. This fuse is 

installed as protection when the DS-Tracer is removed from its case during 

repairs. Contact Daystar, Inc. if you suspect that this fuse has blown. 
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5.0   Pre-Charge Precautions 

In order to compensate for voltage drops across the test leads, the DS-Tracer 

pre-charges the capacitive load to -25 V. When an I-V curve is taken, the PV 

module voltage will start at -25 V and increase to 0 V (Isc) and continue to Voc. 

Most PV modules (single crystal silicon for example) can easily withstand this 

negative pre-charge voltage. However, this pre-charge voltage can damage 

some thin-film modules—particularly those with very low Voc values. Higher 

voltage modules have more cells in series and therefore the pre-charge voltage 

is spread across more cells. Only individual low-voltage, thin-film modules are 

affected. It is not a concern for systems with many modules in series. 

You can avoid damage to a thin-film module by inserting a by-pass diode across 

the module terminals as shown in Figure 10. This diode limits the reverse voltage 

to approximately -1 V maximum. Locating the diode at the PV module terminals 

allows the pre-charge to still offset voltage drops across the test leads. 

The by-pass diode should be rated to handle the instantaneous peak current 

created by shorting the pre-charge capacitor through the by-pass diode. Due to 

circuit resistances, this current will not exceed 250 A and can last less than 2 ms. 

The diode reverse voltage rating must be greater than module Voc. A Motorola 

MR750 series rectifier is recommend. This rectifier has a reverse voltage rating 

of 50 V and can handle peak currents over 300 A. 

 

Figure 10. Use of by-pass diode to protect thin-film PV modules. 
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6.0   DS-100C Additional Capabilities 

The DS-100C tracer has auxiliary capabilities. These include analog circuits for 

reading external temperatures and irradiances. 

Temperature & Irradiance Inputs 

The DS-100C has two thermocouple temperature inputs and two dual, 5-way 

binding posts for connecting pyranometers.  You do not need to use these inputs 

to take I-V curves.  The temperature and irradiance inputs are enabled using the 

AUTO feature of IVPC. When a curve is taken, the temperature and iradiance 

inputs are sampled immediately before the DS-100C takes a curve. Refer to the 

IVPC operating manual for details on using these inputs when taking I-V curves. 

Temperature Connections 

Two standard thermocouple connectors are available on the front of the DS-

100C. A standard DS-100C comes with Type- “T” thermocouple connectors. In 

order to accurately acquire temperature data, only matching thermocouple types 

can be used. The thermocouple inputs are electrically isolated from the PV 

system, but not isolated from other analog circuits or the computer connections. 

Therefore, it is necessary that the thermocouple be electrically insulated when 

bonded to a surface.  

Irradiance Connections 

There are two dual, 5-way binding posts for 
pyranometer inputs located on the front panel of the 
DS-100C. These programmable inputs can 
accommodate ± 5 V signals and accurately measure 
millivolt signals. These inputs can be used for any 
analog voltage measurement within the range of the 
DS-100C. Refer to the 
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Appendix D - DS-100C Technical Specifications for details on measurement 

ranges. 

Multiple Current Ranges 

The standard DS-100C includes two current ranges, 10 Amperes and 100 

Amperes. Before a I-V curve is taken, you may select one of these two ranges 

using IVPC. You will not damage the DS-100 by inadvertently selecting the low 

range when the high range is required.  However, the displayed I-V curve will not 

include current values higher than 10 Amperes. 

External Command Set  

Typically the IVPC program controls the DS-100C, however you can write your 

own program if necessary. Some users may want to write software to perform 

custom tracer operations. This is possible using the following commands sent to 

the DS-100C through its RS-232 serial or USB control ports. 

The DS-100C sends a prompt character “>” when it is ready to receive a 

command line. Commands should only be sent to the DS-Tracer after receiving 

this prompt. Each command has a unique one character start code, indicating 

the type of command, followed by comma-delineated parameters as required. 

After receiving a command line, the DS-Tracer attempts to perform the 

requested operation. If the command and its parameters can be decoded 

properly, the DS-Tracer sends a “*” followed by a carriage return (ASCII 0DH) to 

indicate that the command was accepted. If the command was not accepted, the 

DS-Tracer will return an error line in place of the “*” line . It is this return line that 

should be checked following all commands. Refer to Appendix B    DS-Tracer 

ERROR CODES for a list of error messages. Each command of the DS-Tracer is 

described below with an example of a proper command line and responses from 

the DS-Tracer. 

Note: Optional parameters are shown with brackets []. 



DS-100C Operating Manual IVPC Software Reference page 27 

 

 

Read I & V “B” 

This command reads the DS-100C current and voltage analog-to-digital 

converters (ADCs), and repeatedly outputs their 16 bit integer values until 

another command is received. Note: Any command sent to it to stop this 

command is ignored. Typically this command is used to calibrate the DS-Tracer.  

Note: These values may or may not have had offset correction applied 

depending on the whether the “Z” parameter is passed (see below). 

Format 

“B,n1,n2,[Z]” n1 = Voltage gain code 0,1,2, or 3. 

  n2 = Current gain code 0,1,2, or 3. 

   Z = Use current offset values (see auto 

zero) 

 

Gain Codes 

0 = 1X  used for 600 V, not used for current  

1 = 10X  used for 60 V, 100 A 

2 = 100X  used for 6 V, 10 A 

3 = 1000X  not used for any measurements 

Example 

command “B,0,1” or “B,0,1,Z” 

response “*”  

response “3045”  Voltage A/D Output. 

response “2839”  Current A/D Output. 

delay   

response “3046”  

response “2838”  

Continues until any other command is received.. 

Auto Zero I & V “Z” 

This sets the current circuit offset to the current reads form the PV voltage and 

current channels. Therefore this command should only be used when the current 
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and voltage values are known to be true zeros. This command is typically used 

for calibration purposes. 

 

Format 

“Z,n1,n2” n1 = Voltage gain code 0,1,2, or 3. 

  n2 = Current gain code 0,1,2, or 3. 

     

Gain Codes 

0 = 1X  used for 600 V, not used for current  

1 = 10X  used for 60 V, 100 A 

2 = 100X  used for 6 V, 10 A 

3 = 1000X  not used for any measurements 

Example 

command “Z,0,1”  

response “*” 

response “>”  

Pre-Curve “E” 

This command initiates the pre-curve sequence. The sequence has up to a 5 

second discharge of the tracer load capacitors followed by a 7 second pre-

charge. 

Format 

“E”  Start pre-curve sequence. 

Example 

command “E”  

response “*” 

7 to 12 second delay 

response “>” 
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Read Analog Input “R” 

The read-analog command has a form for reading a specified analog input 

channel,  a form for auto-calibrating the gain of the analog circuits, and a form for 

defining the averaging period for analog readings. 

The analog channels are not related to the circuits used for the current and 

voltage readings. The analog channels refer to the irradiance (pyranometer), and 

temperature readings as well as auxiliary analog port, and internal readings such 

as battery voltage. 

Format 

Option 1 

“R,n1,n2” Read input n1 (0-13). 

  n2 = Pyranometer constant in W/m 2 / volt. 

Only needed if n1 = 2 or 3. 

Option 2 

“R,C”  Calibrate analog board circuits. 

 

Option 3 

“R,P,t”  Set analog averaging period ‘t’ in 

microseconds. 

Option 1 reads one of 14 possible analog inputs. It returns a numeric value for 

the channel. 

 



page 30 IVPC Software Reference DS-100C Operating Manual 

 

”n” Description 

0 Temperature #1 

1 Temperature #2 

2 Irradiance #1 

3 Irradiance #2 

4 Battery Voltage 

5 4 V Reference 

6 0V Reference for 5.0 V scale 

7 0.4 V Reference 

8 0V Reference for 0.50 V scale 

9 40 mV Reference 

0 0V Reference for 50 mV scale 

11 4 mV Reference 

12 0V Reference for 5 mV scale 

13 Thermocouple Reference Junction Temp. 

20 PV Voltage 

Option 2 is used to calibrate the gain of the analog circuit based on the 4 V 

internal reference. The option 2 format does not return any values. 

Option 3 sets the averaging period for all analog readings. The default value is 

16,667 microseconds. This is equal to 1 60 Hz ac power cycle. Averaging over 

one AC cycle helps to reduce AC noise picked up the thermocouples and 

pyranometers. This value is limited to a maximum of 65,535. A value of 0, 

disables all averaging. 

The most common reason to use this command would be to set the tracer to 

cancel power line noise that is not 60Hz. For example, 50 Hz. In that case, the 

averaging constant should be set to 20000. 

Example 1 

command “R,5” Read 2.5 V reference. 

response “*” 

response “2.499” 

response “>” 

Example 2 

command “R,C” Calibrate. 

response “*” 
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response “>” 

Example 3 

command “R,Z,16667”  Set averaging period to 1 60 H z 

period. 

response “*” 

response “>” 

PV V & I Scales Factors “S” 

This command returns the floating-point conversion constant for the PV voltage 

and current inputs for the specified gain codes. There is a different conversion 

constant for each gain code. The integer values returned by the DS-Tracer for 

the PV voltage and current values are multiplied by these constants to convert 

these values to engineering units. The constants are returned in IEEE single 

precision (32 bit) binary format. 

 

Format 

“S,n1,n2” n1 = Voltage gain code 0,1,2, or 3. 

  n2 = Current gain code 0,1,2, or 3. 

 

Gain Codes 

0 = 1 

1 = 10 

2 = 100 

3 = 1000 

 

IEEE 32 bit floating point format: 

1 sign bit, 8 bit signed exponent, 23(+1) bit manti ssa. 

Refer to IEEE documentation for more details. 

Example 

command “S,0,1”  

response “*” 
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4 byte (32 bit) voltage constant 

4 byte (32 bit) current constant 

response “>” 
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Take I-V Curve “T” 

This command causes the DS-Tracer to take an I-V curve using the specified 

current range. The I-V curve data is accessed with the “Transfer” command “X”. 

Format 

“T,L” Use low current range. 

“T,H” Use high current range. 

Example 1 

command “T,L” 

response “*” 

response “>” 

Take low current curve. 

Example 2 

command “T,H” 

response “*” 

response “>” 

Take a high current range curve. 

Read DS-Tracer Version “V” 

This command reads the software version number, current and voltage ranges. 

Format 

“V” 

Example 

command “V” 

response “*” 

response “VERS 6.0C” 

response “V LOW=150V” 

response “V HI=600V” 

response “I LOW=10A” 
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response “I HI=100A” 

response “>” 

Get Information “G” 

This command gets various DS-Tracer information depending on the parameters 

used. Currently two version are define: 

Get Configuration 

“G,C” 

Example 

command “G,C” 

response “*” 

response “123456”  tracer serial number 

response “8-13-06”  date of manufacture 

response “9600”   RS-232 port baud rate 

response “9600”   secondary port baud rate 

response “600”   nominal high-voltage range 

response “150”   nominal low-voltage range 

response “100”   nominal high-current range 

response “10”   nominal low-current range 

response “T”   thermocouple #1 type 

response “T”   thermocouple #2 type 

response “>” 

Get Calibration Constants 

“G,B” 

Example 

command “G,B” 

response “*” 

response “123456”  tracer serial number 

response “8-13-06”  calibration date 

response “0.6”   0.6V voltage constant (NA) 

response “6.1056”  6V range voltage constant 

response “60.1439”  60V range voltage constant 
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response “600.0123”  600V range voltage constant 

response “1.0”   1.0A current constant (NA) 

response “10.0839”  10A range current constant 

response “100.0529”  100A range current constant 

response “1000.0”  1000A current constant (NA) 

response “4.00183E-3” 5 mV analog constant  

response “4.00381E-2” 50 mV analog constant 

response “3.999921-1” 500 mV analog constant 

response “4.00094E-0” 5 V analog constant 

response “-0.35”  CJC offset 

response “>” 
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Disable Power Down “W” 

Normally the DS-Tracer turns itself off after 15 minutes without any activity. This 

command disables this feature until the DS-Tracer is reset by turning power off. 

Format 

“W” 

Example 

command “W” 

response “*” 

response “>” 

Enable Power Down “P” 

Normally the DS-Tracer turns itself off after 15 minutes without any activity. This 

command enables this feature. By default this feature is enable. This command 

is only necessary if the power-down feature has been disabled using the “W” 

command. 

Format 

“P” 

Example 

command “P” 

response “*” 

response “>” 

Transfer Curve Data “X” 

This command is used to transfer curve data from the DS-Tracer. The command 

transfers the I-V curve data in binary format. If there are no errors, this command 

returns “*” followed by a 1056 byte binary data record. 

Format 

“X” Transfer last data record. 
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Binary format. 

   int   Voc;             /* Curve Voc  */ 

   int   Isc;             /* Curve Isc  */ 

   int   Num_Points;      /* Number of data points  

*/ 

   char  V_Gain;          /* V gain code used */ 

   char  I_Gain;          /* I gain code used */ 

   int   Volts[256];  /* Array of voltage data  

*/ 

   int   Amps[256];   /* Array of current data  

*/ 

   float   Vscale;   /* Voltage constant  */ 

   float   Iscale;   /* Current constant  */ 

   float   Temp1;   /* Temperature #1  */ 

   float   Temp2;   /* Temperature #2  */ 

   float   Irrad1;   /* Irradiance #1  */ 

   float   Irrad2;   /* Irradiance #2  */ 

 

int Format: 8 bit MSB|8 bit LSB 

 

IEEE 32 bit floating point format: 

1 sign bit, 8 bit signed exponent, 23(+1) bit manti ssa. 

Refer to IEEE documentation for more details. 

Example 

command “X” 

response “*” 

response 1056 binary bytes 

response “>” 
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7.0   Troubleshooting 
 
• Data is not plotted after taking an I-V curve. 
- Proper connection has not been made to PV system (check 

DISCONNECT switch). 
 
• I-V curve is flat. 
- PV short circuit current exceeds current range (check current range 

setting). Check for bad connections to PV module or array. 
 

• I-V curve does not start at 0 V (does not reach Isc). 
- Pre-charge fuse has blown (check and replace). 
 
• DS-Tracer Stops Working (Locks Up) 
- Battery out of power (charge battery). 
- Unknown Reasons (reset DS-Tracer by recycling power). 
 
• Cannot establish connection of external computer to DS-Tracer. 
- DS-Tracer is not turned on or has turned itself off. 
- DS-Tracer RS-232 or USB port is not connected to computer. 
- IVPC is set to wrong COM port. 
 
• DS-Tracer will not accept external command. 
- Parameters are not properly formatted. 
 
• Irradiance readings are incorrect. 
- Pyranometer coefficients are incorrect. 
- Analog circuit requires factory calibration 



DS-100C Operating Manual page A39 

 

Appendix A   IV Curve ASCII File Format  

Note: Each line of the “.IVA” format starts with a unique ID letter followed by a 

space. The ID letter and space should be used to decode this file. Line 

arrangements are subject to change as additional information is added to this file 

format. 

 “F” curve name 

 “D” date 

 “T” time 

 “S” site 

 “B” sub-system 

 “M” module 

 “P” temperature #1 

 “Q” temperature #2 

 “R” irradiance #1 

 “U” irradiance #2 

 “X” miscellaneous 

 “H” short circuit current 

 “O” open circuit voltage 

 “C” current at peak power 

 “K” voltage at peak power 

 “W” peak power 

 “L” fill factor 

 

   THERE CAN BE 0 TO 257 I-V DATA PAIRS 

 

 “I” current value voltage value   

 “I” current value voltage value  

 “I” current value voltage value 

   . 

   . 

   . 

 “I” current value voltage value 

 “I” current value voltage value 

 “E”  
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Appendix B    DS-Tracer ERROR CODES 

ERROR 10 “I/O ERROR” 

RS-232 serial communications error. Baud rate, parity, number of data 
bits, or number of stop bits is incorrect. DS-Tracer uses 9600 baud, no 
parity, 8 data bits, and 1 stop bit. 

ERROR 13 “UNKNOWN COMMAND” 

Command is not recognized by the DS-Tracer . This may be due to a 
syntax error. 

ERROR 14 “BUFFER OVERFLOW” 

Internal command line buffer overflow. Total number of characters in 
command line cannot exceed 255. 

ERROR 15 “COMMAND LINE OVERFLOW” 

A command has been sent to the DS-Tracer before the previous 
command has finished. Wait for return prompt. 

ERROR 16 “PARAMETER TOO LONG” 

The maximum length of any command line parameter is 15 characters. 

ERROR 17 “TOO MANY PARAMETERS” 

A maximum of 16 parameters (including command code) are allowed. 

ERROR 30 “OVER MAXIMUM VOLTAGE” 

The take I-V curve command cannot continue because the PV system 
voltage exceeds the maximum voltage range (this PV system cannot be 
tested with the DS-Tracer ). 

ERROR 31 “OVER LOW VOLTAGE RANGE” 

The take I-V curve command cannot continue because the PV system 
voltage exceeds the low voltage range (switch to high voltage range). 
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ERROR 32 “INPUT LESS THAN OR EQUAL ZERO VOLTS” 

The take I-V curve command cannot continue because the PV system 
voltage is less than or equal to 0 V. Check PV system and DS-Tracer 
disconnect switches. This error can also be caused by a reverse polarity 
on the DS-Tracer to PV system connection. 

ERROR 40 “DISCONNECT SWITCH IS OFF” 

The DS-Tracer is trying to take an I-V curve, but the DS-Tracer 
DISCONNECT switch is off. 

ERROR 50 “INVALID NUMERIC PARAMETER” 

Parameter must represent valid numeric value. 

ERROR 60 “INVALID ANALOG I/O CHANNEL #” 

The DS-Tracer accepts channel numbers 0 through 13. 

ERROR 63 “DSP ERROR” 

DS-Tracer DSP board has an error. Usually an A/D has failed or the 
connect to the DSP board has failed. 

ERROR  “UNKNOWN ERROR” 

Some type of unknown error has occurred. Check parameters for proper 
syntax.
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Appendix C    DS-100 USB Drivers 

In order to use the DS-100C USB port for tracer control, the DS-100 USB drivers 

must be installed on the computer running IVPC. Two drivers will be installed. 

The primary driver will be a USB device driver labeled “DS-100 IV Tracer”. The 

second driver will be a virtual COM port also labeled “DS-100 Tracer”. This 

virtual COM port will function as a conventional COM port. 

IVPC version 2.X and lower only work with COM ports and therefore require the 

virtual COM port. New versions of IVPC will not need this virtual COM port, but 

still require the USB driver installation. 

IVPC 2.X and lower only support COM ports 1 through 4. Therefore after being 

created, the virtual COM port must be assigned a COM port number in this 

range. It is common for the operating system to assign a COM port number 

outside this range, even if a COM port number from 1 to 4 is not in use.  

Use the Windows OS device manager to change the COM port number assigned 

to this virtual COM port. Often Windows will warn that this COM port is in use. 

But if you know that it is not in use, you can reassign it to the necessary value 

from 1 to 4. After changing the COM port assignment, it is best to restart the 

computer to ensure proper operation. 

Consult the Microsoft documentation and help system for details on using the 

device manager. 

Note: If you have a conventional RS-232 COM port available, there is no 

advantage to using the DS-100C USB port and it is not necessary to install these 

USB drivers. However, many modern notebook computers do not have COM 

ports, and therefore it is necessary to install these DS-100 USB drivers. 

The DS-100 USB drivers are located on the IVPC CD-ROM supplied with the 

tracer in the DS-100 USB Drivers folder. This folder contains detailed instructions 

on how to install the drivers for your version of the operating system. 
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Note: These instructions are not specific to the DS-100C and where provided by 

the USB hardware manufacturer. Therefore these instructions will not refer to the 

DS-100 IV Tracer driver by name. 

When you first connect the DS-100C to your computer using the USB 

connection, Windows will recognize that new hardware has been connected and 

begin the process of installing the driver. The instructions on the CD-ROM 

provide much more detail, but in general, you will want to have Windows use the 

drivers in the driver folder on the IVPC CD-ROM using the “Have Disk” option. 

Follow the steps as outlined in the driver installation instructions. After installation 

confirm that the assigned COM port number is appropriate and if necessary 

change it to a number form 1 to 4 as described above. Also, be sure to set the 

COM port number in IVPC to match this setting. 
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Appendix D - DS-100C Technical Specifications 

PV Voltage Measurements 
Gain Code = 0 
 Range  600 V dc. 
 Accuracy Larger of +/- 0.5% of reading or +/- 0.28 V. 
 Resolution 18 mV. 
 
Gain Code = 1 
 Range  60 V dc. 
 Accuracy Larger of +/- 0.5% of reading or +/- 28 mV. 
 Resolution 1.8 mV. 
 
Gain Code = 2 
 Range  6 V dc. 
 Accuracy Larger of +/- 0.5% of reading or +/- 2.8 mV. 
 Resolution 0.18 mV. 
 

PV Current Measurements  
Gain Code = 1 
 Range  100 A dc 
 Accuracy Larger of +/- 0.5% of reading or +/- 45 m A. 
 Resolution 3 mA. 
 
 
Gain Code = 2 
 Range  10 A dc 
 Accuracy Larger of +/- 0.5% of reading or +/- 4.5 mA. 
 Resolution 0.3 mA. 
 

RANGE switch settings 

VHIGH  600 V dc (max.) 

VLOW  300 V dc (max.) 

 

Temperature Measurement  
  Range  -30°C to 120°C. 
  Accuracy +/- 1°C. 
  Resolution 0.1°C. 
 

Irradiance Measurement 
  Ranges +/-5 V, +/- 500 mV, +/- 50 mV, +/- 5 mV, 
  Accuracy +/- 0.1% of Range. 
  Resolution 1/65,536 of Range. 
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Power Supply 
  Power  85 Vac to 264 Vac V 50/60 Hz ac. 
  Battery 5 A-Hr sealed lead acid.  (Hawker Energy Products #0809-0020) 
  Hours of Use Up to 13 Hours on a full charge. 
  Charge Time Less than 8 hrs. 
 

Load Capacitors 
  Low Voltage Range 
   Capacitance 5,000 uf. 
   Voltage Limit 350 V dc. 
 
  High Voltage Range 
   Capacitance 1,600 uf. 
   Voltage Limit 700 V dc. 
 

Approximate Size &  Weight  

  18” x 14” x 8” (46 cm X 36 cm X 20 cm)   

  28 lbs. (13 kg) 

 


